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1关于本手册 

1.1 手册内容 

本手册内容包括功能描述、硬件板材、软件开发工具、原厂开发资料、

GMD/Keil5 软件支持、XMC 接口以及参考设计等，描述了如何快速建立、

配置、下载和调试硬件工程和软件工程，以及快速查找原厂开发资料，旨在

帮助用户快速掌握 Gowin_EMPU(GW5AS-25)的开发方法，节省开发时

间，提高开发效率。 

注！ 

Gowin_EMPU(GW5AS-25)系统级封装了 Artery 的 Cortex-M4 MCU AT32F435。

Gowin_EMPU(GW5AS-25)为 Gowin 对 Cortex-M4 MCU 的命名方式，表示 GW5AS-25 系

列 FPGA 产品内部系统级封装的 Cortex-M4 MCU。AT32F435 为 Artery 原厂的 Cortex-M4 

MCU 器件型号。 

1.2 相关文档 

通过登录高云半导体网站 www.gowinsemi.com 可以下载、查看以下相

关文档：DS1105，GW5AS-25 器件数据手册。 

1.3 术语、缩略语 

本手册中的相关术语、缩略语及相关释义如表 1-1 所示。 

表 1-1 术语、缩略语 

术语、缩略语 全称 含义 

DMA Direct Memory Access 直接内存访问 

DSP Digital Signal Processor 数字信号处理器 

FPGA Field Programmable Gate Array 现场可编程门阵列 

FPU Float Point Unit 浮点运算单元 

MCU Micro Controller Unit 微控制器单元 

MPU Memory Protection Unit 存储器保护单元 

http://www.gowinsemi.com/
http://cdn.gowinsemi.com.cn/DS1105.pdf
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术语、缩略语 全称 含义 

RISC Reduced Instruction Set 

Computer 

精简指令集计算机 

SIP System In Package 系统级封装 

XMC External Memory Controller 外部存储器控制器 

1.4 技术支持与反馈 

高云半导体提供全方位技术支持，在使用过程中如有疑问或建议，可直

接与公司联系： 

网址：www.gowinsemi.com.cn 

E-mail：support@gowinsemi.com 

Tel：+86 755 8262 0391 

 

http://www.gowinsemi.com.cn/
mailto:support@gowinsemi.com
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2功能简介 

2.1 功能描述 

Gowin_EMPU(GW5AS-25)集成最新一代嵌入式 ARM®内核 Cortex-

M4。 

2.1.1 特性 

ARM® Cortex®-M4 是最新一代的嵌入式 ARM®内核处理器，它是一款

32 位的 RISC 高性能处理器，具有优异的代码效率，卓越的计算性能和先

进的中断系统响应。该处理器支持一组 DSP 指令，能够实现有效的信号处

理和复杂的算法执行。它配有的单精度 FPU 可加速浮点运算并防止饱和。 

Gowin_EMPU(GW5AS-25)的功能特性如下： 

 内核：带有 FPU 的 ARM®32 位的 Cortex®-M4 MCU 

 最高 288 MHz 工作频率，带存储器保护单元（MPU），内建单周期乘法

和硬件除法 

- 内建浮点运算单元（FPU） 

- 具有 DSP 指令集  

 存储器 

- 1024 K 字节的内部闪存存储器 

- sLib：将指定的主存储区设为执行代码安全库区，此区代码仅能调

用无法读取 

- 384 K 字节的 SRAM  

- 具有 16 位数据总线的外部存储器控制器（External Memory 

Controller，XMC）：支持 CF 卡、SRAM、PSRAM、NOR、NAND

和 SDRAM 存储器 

- 多达 2 个 QSPI 接口，用于连接外部 SPI 闪存存储器或 SPI RAM

扩展，支持地址映射模式 
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 XMC 作为 LCD 并口，兼容 8080/6800 模式 

 电源控制（PWC）  

- 2.6V 至 3.6 V 供电  

- 上电复位（POR）、低电压复位（LVR）、电源电压监测器（PVM）  

- 低功耗模式：睡眠、深睡眠和待机 

- VBAT 为 LEXT、ERTC 和 20 个 32 位的电池供电寄存器（BPR）

供电 

 时钟和复位管理（CRM） 

- 4 至 25 MHz 晶振（HEXT） 

- 内置经出厂调校的 48 MHz 高速内部时钟（HICK），25 °C 达 1 %精

度，-40 °C 至+105 °C 达 2.5 %精度，带自动时钟校准（ACC）功

能 

- PLL 可灵活配置倍频和分频系数 

- 32 kHz 晶振（LEXT） 

- 低速内部时钟（LICK） 

 模拟模块 

- 3 个 12 位 5.33 MSPS A/D 转换器，多达 24 个外部输入通道；分辨

率 12/10/8/6 位可调；硬件过采样最高达 16 位分辨率 

- 温度传感器（VTS）、内部参考电压（VINTRV）、VBAT 电池电压监

控（VBAT/4） 

- 2 个 12 位 D/A 转换器 

 直接内存访问（DMA） 

- 2 个通用型 DMA 和 1 个增强型 EDMA 控制器 

- 合计 22 通道 

 多达 94 个快速 GPIO  

- 所有 GPIO 可以映像到 16 个外部中断（EXINT） 

- 几乎所有 GPIO 可支持 5V 输入信号 

 多达 18 个定时器（TMR） 

- 多达 13 个 16 位和 2 个 32 位定时器，每个定时器最多达 4 个用于

输入/输出/PWM/脉冲计数的通道 

- 2 个看门狗定时器（一般型 WDT 和窗口型 WWDT） 

- 系统滴答定时器：24 位递减计数器 

 ERTC：增强型 RTC，具有自动唤醒、闹钟、亚秒级精度及硬件日历，

带校准功能 
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 多达 23 个通信接口 

- 多达 3 个 I2C 接口，支持 SMBus/PMBus 

- 多达 4 个 USART/4 个 UART 接口，支持 ISO7816、LIN、IrDA 接

口、调制解调控制和 RS485 驱动使能，支持 TX/RX 可配置引脚互

换 

- 多达 4 个 SPI 接口（36 M 位/秒），4 个均可用为 I2S 接口，其中

I2S2/I2S3 支持全双工 

- 多达 2 个 CAN 接口（2.0B 主动） 

- 多达 2 个 OTG 全速控制器，设备模式时支持无晶振（Crystal-

less） 

- 多达 2 个 SDIO 接口 

- 红外发射器（IRTMR） 

 8~14 位数字摄像头并口（DVP） 

 CRC 计算单元 

 96 位的芯片唯一码（UID） 

 调试模式 

- 串行线调试（SWD）和 JTAG 接口 

 温度范围：-40 至+105 °C 

2.1.2 功能框图 

Gowin_EMPU(GW5AS-25)的功能框图如图 2-1 所示。 
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图 2-1 功能框图 
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2.2 硬件板材 

 DK_Motor_GW5AS-EV25UG256C2I1_V1.0 

GW5AS-EV25UG256C1/I0 

GW5AS-25 A 版 
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2.3 软件工具 

Gowin_EMPU(GW5AS-25)的软件开发工具包括 Gowin、ARM、Artery

三方的软件开发工具如表 2-1 所示。 

注！ 

如有更新版本，请在 Artery 网站下载更新：

https://www.arterytek.com/cn/product/AT32F435.jsp 

表 2-1 软件开发工具 

开发工具 SDK/下载位置 

Gowin_V1.9.9.02 

(64-bit) 

Gowin 软件工具 

http://www.gowinsemi.com.cn 

GMD_V1.2 Gowin 软件工具 

http://www.gowinsemi.com.cn 

ARM Keil MDK V5 ARM 软件工具 

https://developer.arm.com 

ICP Artery 软件工具 

…\sdk\artery\tool\Artery_ICP_Programmer_V3.0.12.zip 

https://www.arterytek.com/download/TOOL/Artery_ICP_Programmer_V3.0.12.

zip 

ISP Artery 软件工具 

…\sdk\artery\tool\Artery_ISP_Programmer_V2.0.11.zip 

https://www.arterytek.com/download/TOOL/Artery_ISP_Programmer_V2.0.11.

zip 

AT32 IDE Artery 软件工具 

Windows：https://www.arterytek.com/file/download/1738 

Linux：https://www.arterytek.com/file/download/1737 

New Clock 

Configuration 

Artery 软件工具 

…\sdk\artery\tool\AT32_New_Clock_Configuration_V3.0.09.zip 

https://www.arterytek.com/download/TOOL/AT32_New_Clock_Configuration_

V3.0.09.zip 

I2C Timing 

Configuration 

Artery 软件工具 

…\sdk\artery\tool\Artery_I2C_Timing_Configuration_V2.0.5.zip 

https://www.arterytek.com/download/TOOL/Artery_I2C_Timing_Configuration_

V2.0.5.zip 

CAN BitRate 

Configuration 

Artery 软件工具 

…\sdk\artery\tool\Artery_CAN_BitRate_Configuration_V1.0.01.zip 

https://www.arterytek.com/download/TOOL/Artery_CAN_BitRate_Configuratio

n_V1.0.01.zip 

https://www.arterytek.com/cn/product/AT32F435.jsp
http://www.gowinsemi.com.cn/
http://www.gowinsemi.com.cn/
https://developer.arm.com/
https://www.arterytek.com/download/TOOL/Artery_ICP_Programmer_V3.0.12.zip
https://www.arterytek.com/download/TOOL/Artery_ICP_Programmer_V3.0.12.zip
https://www.arterytek.com/download/TOOL/Artery_ISP_Programmer_V2.0.11.zip
https://www.arterytek.com/download/TOOL/Artery_ISP_Programmer_V2.0.11.zip
https://www.arterytek.com/file/download/1738
https://www.arterytek.com/file/download/1737
https://www.arterytek.com/download/TOOL/AT32_New_Clock_Configuration_V3.0.09.zip
https://www.arterytek.com/download/TOOL/AT32_New_Clock_Configuration_V3.0.09.zip
https://www.arterytek.com/download/TOOL/Artery_I2C_Timing_Configuration_V2.0.5.zip
https://www.arterytek.com/download/TOOL/Artery_I2C_Timing_Configuration_V2.0.5.zip
https://www.arterytek.com/download/TOOL/Artery_CAN_BitRate_Configuration_V1.0.01.zip
https://www.arterytek.com/download/TOOL/Artery_CAN_BitRate_Configuration_V1.0.01.zip
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 ICP 

ICP Programmer 是为了让用户更方便的使用 Artery 的 MCU 而开发的

一款图形界面应用程序。使用该应用程序，用户须通过 AT-Link 仿真器或者

J-Link 仿真器来操作 Artery 的 MCU 设备。 

 ISP 

ISP Programmer 是为了让用户更方便的使用 Artery 的 MCU 而开发的

一款界面应用程序。使用该应用程序，用户可以通过 UART 端口或者 USB

端口配置操作 Artery 的 MCU 设备。 

 AT32 IDE 

支持 AT32 MCU 的基于 Eclipse 开发的跨平台 ARM 嵌入式系统的软件

开发环境。 

 New Clock Configuration 

支持 AT32 MCU 的时钟配置。 

 I2C Timing Configuration 

支持 I2C 时序配置工具。 

 CAN BitRate Configuration 

支持 AT32 MCU CAN 波特率配置工具。 

2.4 软件固件库 

Gowin_EMPU(GW5AS-25)的软件固件库由 Artery 提供，支持

AT32F435 底层驱动源代码，以固件库（Firmware Library）呈现如表 2-2

所示。 

注！ 

如有更新版本，请在 Artery 网站下载更新：

https://www.arterytek.com/cn/product/AT32F435.jsp 

表 2-2 软件固件库 

软件固件库 SDK/下载位置 

Firmware 

Library 

…\sdk\artery\bsp\AT32F435_437_Firmware_Library_V2.1.4.zip 

https://www.arterytek.com/download/BSP/AT32F435_437_Firmware_Library_V2.1.4.zip 

2.5 器件包 

Gowin_EMPU(GW5AS-25)的器件包由 Artery 提供，包括 ARM Keil4 

MDK、ARM Keil5 MDK、IAR、Segger 等软件的器件包如表 2-3 所示。 

注！ 

如有更新版本，请在 Artery 网站下载更新：

https://www.arterytek.com/cn/product/AT32F435.jsp 

https://www.arterytek.com/cn/product/AT32F435.jsp
https://www.arterytek.com/download/BSP/AT32F435_437_Firmware_Library_V2.1.4.zip
https://www.arterytek.com/cn/product/AT32F435.jsp
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表 2-3 器件包 

器件包 SDK/下载位置 

Keil4 …\sdk\artery\pack\Keil4_AT32MCU_AddOn_V2.2.4.zip 

https://www.arterytek.com/download/PACK/Keil4_AT32MCU_AddOn_V2.2.4.zip 

Keil5 …\sdk\artery\pack\Keil5_AT32MCU_AddOn_V2.2.7.zip 

https://www.arterytek.com/download/PACK/Keil5_AT32MCU_AddOn_V2.2.7.zip 

IAR …\sdk\artery\pack\IAR_AT32MCU_AddOn_V2.1.9.zip 

https://www.arterytek.com/download/PACK/IAR_AT32MCU_AddOn_V2.1.9.zip 

Segger …\sdk\artery\pack\Segger_AT32MCU_AddOn_V2.0.9.zip 

https://www.arterytek.com/download/PACK/Segger_AT32MCU_AddOn_V2.0.9.zip 

2.6 参考手册 

Gowin_EMPU(GW5AS-25)的参考手册由 Artery 提供，包括数据手

册、固件库编程指南、入门指南、应用笔记等如表 2-4 所示。 

Gowin 仅提供本手册，旨在帮助用户快速入门。 

注！ 

如有更新版本，请在 Artery 网站下载更新：

https://www.arterytek.com/cn/product/AT32F435.jsp 

表 2-4 参考手册 

参考手册 SDK/下载位置 

数据手册 

数据手册 …\sdk\artery\doc\datasheet\ DS_AT32F435_437_V2.11_CH.pdf 

https://www.arterytek.com/download/DS/DS_AT32F435_437_V2.11_CH.pdf 

编程指南 

编程指南 …\sdk\artery\doc\programming\RM_AT32F435_437_CH_V2.05.pdf 

https://www.arterytek.com/download/RM/RM_AT32F435_437_CH_V2.05.pdf 

入门指南 

入门指南 …\sdk\artery\doc\getting_start\AN0128_AT32F435_437_Get_started_guide_ZH_V2.0.3

.pdf 

…\sdk\artery\doc\getting_start\AN0083_AT32_MCU_M4_Start_Guide_ZH_V2.0.1.pdf 

…\sdk\artery\doc\getting_start\AN0176_AT32IDE_Quickly_Start_Guide_ZH_V1.0.0.pdf 

https://www.arterytek.com/download/APNOTE/AN0128_AT32F435_437_Get_started_g

uide_ZH_V2.0.3.pdf 

https://www.arterytek.com/file/download/1573 

https://www.arterytek.com/file/download/718 

应用笔记 

XMC …\sdk\artery\app_note\XMC\AN0068_PSRAM_SRAM_XMC_HW_advice_ZH_V2.0.1.p

https://www.arterytek.com/download/PACK/Keil4_AT32MCU_AddOn_V2.2.4.zip
https://www.arterytek.com/download/PACK/Keil5_AT32MCU_AddOn_V2.2.7.zip
https://www.arterytek.com/download/PACK/IAR_AT32MCU_AddOn_V2.1.9.zip
https://www.arterytek.com/download/PACK/Segger_AT32MCU_AddOn_V2.0.9.zip
https://www.arterytek.com/cn/product/AT32F435.jsp
https://www.arterytek.com/download/DS/DS_AT32F435_437_V2.11_CH.pdf
https://www.arterytek.com/download/RM/RM_AT32F435_437_CH_V2.05.pdf
https://www.arterytek.com/download/APNOTE/AN0128_AT32F435_437_Get_started_guide_ZH_V2.0.3.pdf
https://www.arterytek.com/download/APNOTE/AN0128_AT32F435_437_Get_started_guide_ZH_V2.0.3.pdf
https://www.arterytek.com/file/download/1573
https://www.arterytek.com/file/download/718
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参考手册 SDK/下载位置 

df 

…\sdk\artery\app_note\XMC\AN0106_AT32_MCU_XMC_Application_Note_ZH_V2.0.1.

pdf 

https://www.arterytek.com/file/download/760 

https://www.arterytek.com/file/download/1303 

sLib …\sdk\artery\app_note\sLib\AN0081_AT32F435_437_Security_Library_Application_Not

e_ZH_V2.0.0.pdf 

https://www.arterytek.com/download/APNOTE/AN0081_AT32F435_437_Security_Librar

y_Application_Note_ZH_V2.0.0.pdf 

FPU …\sdk\artery\app_note\AN0037_How_to_use_FPU_ZH_V2.0.0.pdf 

https://www.arterytek.com/file/download/515 

FreeRTOS …\sdk\artery\app_note\RTOS_FreeRTOS\AN0025_FreeRTOS_on_AT32_MCU_ZH_V2

.0.0.pdf 

…\sdk\artery\app_note\RTOS_FreeRTOS\AN0025_FreeRTOS_on_AT32_MCU_V2.0.4.

zip 

https://www.arterytek.com/file/download/1323 

https://www.arterytek.com/file/download/1324 

RT-Thread …\sdk\artery\app_note\RTOS_RTThread\AN0067_RT-

Thread_porting_to_AT32_ZH_V2.0.0.pdf 

https://www.arterytek.com/file/download/561 

WDT/WW

DT 

…\sdk\artery\app_note\WDT\AN0045_AT32_WDT_WWDT_Application_Note_ZH_V2.0.

1.pdf 

https://www.arterytek.com/file/download/534 

ERTC …\sdk\artery\app_note\ERTC\AN0047_AT32_ERTC_Application_Note_ZH_V2.0.2.pdf 

…\sdk\artery\app_note\ERTC\AN0047_AT32_ERTC_Application_Note_V2.0.2.zip 

https://www.arterytek.com/file/download/538 

https://www.arterytek.com/file/download/539 

Timer …\sdk\artery\app_note\Timer\AN0085_AT32_MCU_TMR_Start_Guide_ZH_V2.0.3.pdf 

https://www.arterytek.com/file/download/1294 

DVP …\sdk\artery\app_note\DVP\AN0087_AT32_MCU_DVP_Application_Note_ZH_V2.0.1.p

df 

https://www.arterytek.com/file/download/1555 

QSPI …\sdk\artery\app_note\QSPI\AN0088_AT32_MCU_QSPI_Application_Note_ZH_V2.0.3

.pdf 

https://www.arterytek.com/file/download/1632 

SDRAM …\sdk\artery\app_note\SDRAM\AN0089_AT32_MCU_SDRAM_Application_Note_ZH_

V2.0.0.pdf 

https://www.arterytek.com/file/download/605 

https://www.arterytek.com/file/download/760
https://www.arterytek.com/file/download/1303
https://www.arterytek.com/download/APNOTE/AN0081_AT32F435_437_Security_Library_Application_Note_ZH_V2.0.0.pdf
https://www.arterytek.com/download/APNOTE/AN0081_AT32F435_437_Security_Library_Application_Note_ZH_V2.0.0.pdf
https://www.arterytek.com/file/download/515
https://www.arterytek.com/file/download/1323
https://www.arterytek.com/file/download/1324
https://www.arterytek.com/file/download/561
https://www.arterytek.com/file/download/534
https://www.arterytek.com/file/download/538
https://www.arterytek.com/file/download/539
https://www.arterytek.com/file/download/1294
https://www.arterytek.com/file/download/1555
https://www.arterytek.com/file/download/1632
https://www.arterytek.com/file/download/605
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参考手册 SDK/下载位置 

EDMA …\sdk\artery\app_note\EDMA\AN0090_AT32F435_437_EDMA_Application_Note_ZH_

V2.0.2.pdf 

https://www.arterytek.com/file/download/607 

I2C …\sdk\artery\app_note\I2C\AN0091_AT32F435_437_I2C_Application_Note_ZH_V2.0.1

.pdf 

…\sdk\artery\app_note\I2C\AN0091_AT32F435_437_I2C_Application_Note_V2.0.1.zip 

https://www.arterytek.com/file/download/1365 

https://www.arterytek.com/file/download/1366 

Performan

ce 

…\sdk\artery\app_note\Performance\AN0092_AT32F435_437_Performance_Improve_

ZH_V2.0.0.pdf 

https://www.arterytek.com/file/download/1301 

ADC …\sdk\artery\app_note\ADC\AN0093_AT32F435_437_ADC_Application_Note_ZH_V2.

0.1.pdf 

https://www.arterytek.com/file/download/612 

USB Host 

Library 

…\sdk\artery\app_note\USB_Host_LIB\AN0094_AT32_MCU_USB_Host_Library_Applic

ation_Note_ZH_V2.0.1.pdf 

https://www.arterytek.com/file/download/1556 

CAN …\sdk\artery\app_note\CAN\AN0095_AT32_MCU_CAN_Application_Note_ZH_V2.0.1.

pdf 

…\sdk\artery\app_note\CAN\AN0095_AT32_MCU_CAN_Application_Note_V2.0.1.zip 

https://www.arterytek.com/file/download/619 

https://www.arterytek.com/file/download/620 

GPIO …\sdk\artery\app_note\GPIO\AN0096_AT32F435_437_GPIO_Application_Note_ZH_V

2.0.0.pdf 

https://www.arterytek.com/file/download/1373 

USB 

Device 

Library 

…\sdk\artery\app_note\USB_Device_LIB\AN0097_AT32_MCU_USB_Device_Library_A

pplication_Note_ZH_V2.0.2.pdf 

https://www.arterytek.com/file/download/753 

OTGFS …\sdk\artery\app_note\OTGFS\AN0098_AT32F435_437_OTGFS_Application_Note_Z

H_V2.0.0.pdf 

https://www.arterytek.com/file/download/1375 

USART …\sdk\artery\app_note\USART\AN0099_AT32_MCU_USART_Application_Note_ZH_V

2.0.0.pdf 

https://www.arterytek.com/file/download/1575 

PWC …\sdk\artery\app_note\PWC\AN0100_AT32_MCU_PWC_Application_Note_ZH_V2.0.1.

pdf 

https://www.arterytek.com/file/download/1629 

DAC …\sdk\artery\app_note\DAC\AN0101_AT32_MCU_DAC_Application_Note_ZH_V2.0.1.

https://www.arterytek.com/file/download/607
https://www.arterytek.com/file/download/1365
https://www.arterytek.com/file/download/1366
https://www.arterytek.com/file/download/1301
https://www.arterytek.com/file/download/612
https://www.arterytek.com/file/download/1556
https://www.arterytek.com/file/download/619
https://www.arterytek.com/file/download/620
https://www.arterytek.com/file/download/1373
https://www.arterytek.com/file/download/753
https://www.arterytek.com/file/download/1375
https://www.arterytek.com/file/download/1575
https://www.arterytek.com/file/download/1629
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参考手册 SDK/下载位置 

pdf 

https://www.arterytek.com/file/download/1558 

SPI/I2S …\sdk\artery\app_note\SPI&I2S\AN0102_AT32_MCU_SPI_I2S_Application_Note_ZH_

V2.0.1.pdf 

https://www.arterytek.com/file/download/1617 

DMA …\sdk\artery\app_note\DMA\AN0103_AT32F435_437_DMA_Application_Note_ZH_V2.

0.1.pdf 

https://www.arterytek.com/file/download/631 

EXINT …\sdk\artery\app_note\EXINT\AN0104_AT32_MCU_EXINT_Application_Note_ZH_V2.

0.0.pdf 

https://www.arterytek.com/file/download/1619 

SDIO …\sdk\artery\app_note\SDIO\AN0105_AT32_MCU_SDIO_Application_Note_ZH_V2.0.0

.pdf 

https://www.arterytek.com/file/download/1621 

ACC …\sdk\artery\app_note\ACC\AN0107_AT32_MCU_ACC_Application_Note_ZH_V2.0.1.

pdf 

https://www.arterytek.com/file/download/1623 

CRC …\sdk\artery\app_note\CRC\AN0109_AT32_MCU_CRC_Application_Note_ZH_V2.0.0.

pdf 

…\sdk\artery\app_note\CRC\AN0109_AT32_MCU_CRC_Application_Note_V2.0.0.zip 

https://www.arterytek.com/file/download/639 

https://www.arterytek.com/file/download/640 

Flash …\sdk\artery\app_note\Flash\AN0014_AT32 系列

flash_application_note_ZH_V2.0.2.pdf 

…\sdk\artery\app_note\Flash\AN0014_FLASH_Application_Note_V2.0.2.zip 

https://www.arterytek.com/file/download/1581 

https://www.arterytek.com/file/download/1582 

DSP …\sdk\artery\app_note\DSP\AN0036_DSP_Instruction_and_Library_on_AT32_ZH_V2.

0.1.pdf 

…\sdk\artery\app_note\DSP\AN0036_DSP_Instruction_and_Library_on_AT32_V2.0.1.zi

p 

https://www.arterytek.com/file/download/512 

https://www.arterytek.com/file/download/513 

MODBUS …\sdk\artery\app_note\MODBUS\AN0131_Modbus_on_AT32_MCU_ZH_V2.0.0.pdf 

…\sdk\artery\app_note\MODBUS\AN0131_Modbus_on_AT32_MCU_V2.0.0.zip 

https://www.arterytek.com/file/download/675 

https://www.arterytek.com/file/download/676 

Random …\sdk\artery\app_note\Random\AN0175_AT32_MCU_Make_Random_Number_ZH_V2

https://www.arterytek.com/file/download/1558
https://www.arterytek.com/file/download/1617
https://www.arterytek.com/file/download/631
https://www.arterytek.com/file/download/1619
https://www.arterytek.com/file/download/1621
https://www.arterytek.com/file/download/1623
https://www.arterytek.com/file/download/639
https://www.arterytek.com/file/download/640
https://www.arterytek.com/file/download/1581
https://www.arterytek.com/file/download/1582
https://www.arterytek.com/file/download/512
https://www.arterytek.com/file/download/513
https://www.arterytek.com/file/download/675
https://www.arterytek.com/file/download/676
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参考手册 SDK/下载位置 

.0.0.pdf 

…\sdk\artery\app_note\Random\AN0175_AT32_MCU_Make_Random_Number_V2.0.0.

zip 

https://www.arterytek.com/file/download/777 

https://www.arterytek.com/file/download/778 

CRM …\sdk\artery\app_note\CRM\AN0084_AT32F435_437_CRM_Start_Guide_ZH_V2.0.5.p

df 

https://www.arterytek.com/file/download/1633 

2.7 常见问题 

Gowin_EMPU(GW5AS-25)的常见问题由 Artery 提供，本手册只列出

几个与 J-Link 仿真器下载与单步调试相关的常见问题如表 2-5 所示，更多

的常见问题，请在 Artery 网站查找：

https://www.arterytek.com/cn/support/index.jsp?index=0。 

注！ 

如有更新版本，请在 Artery 网站下载更新：

https://www.arterytek.com/cn/product/AT32F435.jsp 

表 2-5 常见问题 

常见问题 SDK/下载位置 

FAQ0008 …\sdk\artery\faq\FAQ0008_Keil_IAR 项目内 Jlink 无法找到 IC 问题_V2.0.1.pdf 

https://www.arterytek.com/file/download/134 

FAQ0009 …\sdk\artery\faq\FAQ0009_J-Link 下载代码异常说明_V2.0.0.pdf 

https://www.arterytek.com/file/download/136 

FAQ0132 …\sdk\artery\faq\FAQ0132_JLink 手动添加 Artery MCU_V2.0.0.zip 

…\sdk\artery\faq\FAQ0132_JLink 手动添加 Artery MCU_V2.0.pdf 

https://www.arterytek.com/file/download/375 

https://www.arterytek.com/file/download/374 

https://www.arterytek.com/file/download/777
https://www.arterytek.com/file/download/778
https://www.arterytek.com/cn/support/index.jsp?index=0
https://www.arterytek.com/cn/product/AT32F435.jsp
https://www.arterytek.com/file/download/134
https://www.arterytek.com/file/download/136
https://www.arterytek.com/file/download/375
https://www.arterytek.com/file/download/374
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3板材支持 

3.1 板材选择 

选用板材 DK_Motor_GW5AS-EV25UG256C2I1_V1.0 如图 3-1 所示。 

图 3-1 板材选用 

 

3.2 板材设置 

启动模式引脚、串口/USB1、复位引脚的设置如表 3-1 所示。 

表 3-1 板材设置 

功能 引脚 设置方法 

启动模式 BOOT0 和 BOOT1 BOOT0 = 0 

BOOT1 = 0 

JP16-2 和 3 跳线帽短接 

JP15-2 和 3 跳线帽短接 
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功能 引脚 设置方法 

串口 USART1 J8-8：TX 

J8-10：RX 

J17-2 和 4 跳线帽短接 

J17-1 和 3 跳线帽短接 

USB OTG1 X_OTG1_VBUS 

X_OTG1_ID 

J17-3 和 5 跳线帽短接 

J17-4 和 6 跳线帽短接 

MCU 复位 KEY3 - 

 

下载/调试引脚与 J-Link 仿真器的连接方法如表 3-2 所示。 

表 3-2 与 J-Link 仿真器连接 

JTAG/SWD 板材引脚 J-Link 引脚 

SWDIO J8-3 J7 

SWCLK J8-5 J9 

GND J8-9 J4、6、8、10、12、14、16、18、20 
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4GMD 软件支持 

高云 GMD 软件支持 Gowin_EMPU(GW5AS-25)的软件编程设计。 

4.1 软件安装与配置 

高云半导体网站提供 GMD 软件安装包下载： 

http://www.gowinsemi.com.cn/prodshow.aspx 

GMD 软件安装与配置，请参考 SUG549, GOWIN MCU Designer 用户
指南。 

4.2 软件使用流程 

使用 GMD 软件进行 Gowin_EMPU(GW5AS-25)软件编程设计，需要

创建工程、配置选项、编写代码、编译、下载和单步调试。 

4.2.1 创建工程 

创建工程 

选择工具栏“New”（ ）或菜单栏“File > New > C Project”如图

4-1 所示。 

例如： 

 建立项目名称和项目位置； 

 选择项目类型“Empty Project”； 

 选择编译工具链“ARM Cross GCC”。 

http://www.gowinsemi.com.cn/prodshow.aspx
http://cdn.gowinsemi.com.cn/SUG549.pdf
http://cdn.gowinsemi.com.cn/SUG549.pdf
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图 4-1 创建工程 

 

 

选择平台配置类型 

选择平台配置类型“Debug”和“Release”如图 4-2 所示。 

图 4-2 选择平台配置类型 

 

 

选择编译工具链和路径 

选择编译工具链“GNU MCU Eclipse ARM Embedded GCC (arm-

none-eabi-gcc)”及其所在路径，推荐默认配置 Toolchain name 和
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Toolchain path 如图 4-3 所示。 

图 4-3 选择编译工具链及路径 

 

 

建立软件项目 

完成软件工程创建后，在 Project Explorer 视图中选择新建的项目工

程，添加软件项目结构与代码，加入软件编程设计。 

在 Project Explorer 视图中选定当前工程，右键选择“Refresh”选

项，可以自动更新当前软件工程的项目结构和代码。 

4.2.2 配置选项 

Project Explorer 视图中，选定当前软件工程，右键选择“Properties > 

C/C++ Build > Settings”，配置当前软件工程的参数选项，包括： 

 Target Processor 

 Optimization 

 Warnings 

 Debugging 

 GNU ARM Cross Assembler 

 GNU ARM Cross C Compiler 

 GNU ARM Cross C Linker 

 GNU ARM Cross Create Flash Image 

 Toolchains 

 Devices 
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配置 Target Processor 

配置“Target Processor > ARM family、Float ABI、FPU Type”等选

项如图 4-4 所示。 

例如： 

 ARM family：cortex-m4 

 Float ABI：FP instructions (hard) 

 FPU Type：fpv4-sp-d16 

图 4-4 配置 Target Processor 

 

 

配置 Optimization 

配置“Optimization”选项如图 4-5 所示。 

例如： 

 Optimization Level：None (-O0) 

 Function sections (-ffunction-sections)：勾选 
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图 4-5 配置 Optimization 

 
 

配置 Warnings 

配置“Warnings”选项如图 4-6 所示。 
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图 4-6 配置 Warnings 

 

 

配置 Debugging 

配置“Debugging”选项如图 4-7 所示。 

例如： 

Debug level：Default (-g) 
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图 4-7 配置 Debugging 

 

 

配置 GNU ARM Cross C Compiler 

配置“GNU ARM Cross C Compiler > Preprocessor > Defined 

symbols (-D)”选项如图 4-8 所示。 

例如： 

AT32F435 

USE_STDPERIPH_DRIVER 

AT_START_F435_V1 
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图 4-8 配置 GNU ARM Cross C Compiler > Preprocessor 

 

 

配置“GNU ARM Cross C Compiler > Includes > Include paths (-I)”

选项如图 4-9 所示。 

例如： 

“${workapce_loc:/${ProjName}/libraries/cmsis/cm4/core_support}” 

“${workapce_loc:/${ProjName}/libraries/cmsis/cm4/device_support}

” 

“${workapce_loc:/${ProjName}/libraries/drivers/inc}” 

“${workapce_loc:/${ProjName}/demo/board}” 

“${workapce_loc:/${ProjName}/demo/example/inc}” 



4 GMD 软件支持 4.2 软件使用流程 

 

MUG1186-1.1 24(53) 

 

图 4-9 配置 GNU ARM Cross C Compiler > Includes 

 
 

配置“GNU ARM Cross C Compiler > Optimization”选项如图 4-10 所

示。 

例如： 

Language standard：ISO C99 (-std=c99) 
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图 4-10 配置 GNU ARM Cross C Compiler > Optimization 

 

 

配置 GNU ARM Cross C Linker 

配置“GNU ARM Cross C Linker > General > Script files (-T)”选项，

如图 4-11 所示。 

例如： 

“${workspace_loc:/${ProjName}/libraries/cmsis/cm4/device_support/l

inker/AT32F435xG_FLASH.ld}” 
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图 4-11 配置 GNU ARM Cross C Linker > General 

 
 

配置“GNU ARM Cross C Linker > Miscellaneous”选项如图 4-12 所

示。 

例如： 

 Use newlib-nano (--spes=nano.specs)：勾选 

 Do not use syscals (--specs=nosys.specs)：勾选 
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图 4-12 配置 GNU ARM Cross C Linker > Miscellaneous 

 

 

配置 GNU ARM Cross Create Flash Image 

配置“GNU ARM Cross Create Flash Image > Output file format (-

O)”选项如图 4-13 所示。 

例如： 

Output file format (-O)：Intel HEX 
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图 4-13 配置 GNU ARM Cross Create Flash Image 

 

 

配置 Toolchains 

配置“Toolchains”选项如图 4-14 所示。 

例如： 

 C compiler：gcc 

 C++ compiler：g++ 

 Toolchain path：D:\GMD\toolchain\ARM_toolchain\bin 

 Build tools path：D:\GMD\toolchain\GNU MCU Eclipse\Build 

Tools\2.11-20180428-1604\bin 

 Create flash image：勾选 

 Print size：勾选 
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图 4-14 配置 Toolchains 

 

 

配置 Devices 

配置“Devices”选项如图 4-15 所示。 

例如： 

Devices > ARM > ARM Cortex-M4 > ARMCM4_FP 
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图 4-15 配置 Devices 

 

4.2.3 编译 

完成软件工程选项配置和代码编写后，编译当前软件工程，单击工具栏

Build“ ”或 Build All“ ”，或菜单栏“Project > Build Project”或

“Project > Build All”编译产生软件编程设计 HEX 文件，如图 4-16 所示。 
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图 4-16 编译 

 

4.2.4 下载 

完成软件工程编译后，参照表 3-2 的方式连接 J-Link 仿真器后，使用

ICP 软件工具，下载软件编程设计 HEX 文件，如图 4-17 和图 4-18 所示。 

以管理员身份运行 ICP 软件工具： 

 切换仿真器类型为 J-Link，单击“连接”； 

 添加要下载的软件编程设计 HEX 文件，界面会显示文件信息、存储器

信息等； 

 单击“下载”。 
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图 4-17 ICP 软件工具 

 

 

图 4-18 下载 
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4.2.5 单步调试 

完成软件编程设计 HEX 文件下载后，如果用户软件编程设计出现问

题，可以使用 J-Link 仿真器单步调试当前软件编程设计。 

注！ 

单步调试前，请参照表 2-5 常见问题的 FAQ0009 和 FAQ0132 配置 Segger J-Link 驱动软

件的 Artery 器件。 

单步调试流程包括： 

 配置单步调试选项 

 连接调试仿真器 

 启动单步调试 

配置单步调试选项 

选择菜单栏“Run > Debug Configurations > GDB SEGGER J-Link 

Debugging”，右键选择“New”选项，建立当前软件工程的调试配置选

项，如图 4-19 所示。 

图 4-19 建立单步调试选项 

 
 

1. 配置 Main 选项 

选择已建立的单步调试选项的“Main”选项，配置当前调试软件工程

的 Project 和 C/C++ Application 等选项，如图 4-20 所示。 
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图 4-20 配置 Main 选项 

 
 

2. 配置 Debugger 选项 

选择已建立的单步调试选项的“Debugger”选项，配置当前调试软件

工程的 J-Link 和 GDB 等选项，如图 4-21 所示。 

例如： 

 Device name：AT32F435 或-AT32F435（如果已使用过 ICP 软件工

具） 

 Endianness：Little 

 Connection：USB 

 Interface：SWD 

 Verify downloads：默认勾选 

 Initialize registers on start：默认勾选 

 Local host only：默认勾选 
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图 4-21 配置 Debugger 选项 

 
 

3. 配置 Startup 选项 

选择已建立的单步调试选项的“Startup”选项，配置当前调试软件工

程的 Startup 等选项，如图 4-22 所示。 

例如： 

 Enable semihost：不勾选；如果勾选，控制台可能会输出乱码 

 Enable SWO：不勾选；如果勾选，控制台可能会输出乱码 

 Pre-run/Restart reset：勾选 

 Set breakpoint at: main：勾选 

 Continue：勾选 
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图 4-22 配置 Startup 选项 

 

 

启动单步调试 

单击工具栏 Debug“ ”，选择当前软件工程的 Debug 配置，单击

进入单步调试状态，执行断点设置、单步调试、复位和运行等操作，如图

4-23 所示。 
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图 4-23 启动单步调试 

 

4.3 参考设计 

Gowin_EMPU(GW5AS-25)支持 GMD（已测试软件版本：V1.2）软件

的软件编程参考设计，通过点击此链接 Gowin_EMPU(GW5AS-

25)_V1.0.zip 获取如下参考设计： 

…\sdk\gowin\ref_design\MCU_RefDesign\GMD_RefDesign\usart1_pri

ntf 

…\sdk\gowin\ref_design\MCU_RefDesign\GMD_RefDesign\freertos 

…\sdk\gowin\ref_design\MCU_RefDesign\GMD_RefDesign\rt_thread

_nano 

…\sdk\gowin\ref_design\MCU_RefDesign\GMD_RefDesign\ucos_iii 

 

https://cdn.gowinsemi.com.cn/Gowin_EMPU(GW5AS-25)_V1.0.zip
https://cdn.gowinsemi.com.cn/Gowin_EMPU(GW5AS-25)_V1.0.zip
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5 Keil5 软件支持 

对于 ARM Cortex-M4 MCU，传统的通用的方式是使用 Keil5 软件。本

节重点描述如何使用 Artery 提供的 Keil5 软件的器件包，在 Keil5 软件中支

持 Gowin_EMPU(GW5AS-25)，Keil5 软件的安装和使用本手册不在描述。 

5.1 器件包安装 

Artery 器件

包：…\sdk\atery\pack\Keil5_AT32MCU_AddOn_V2.2.7.zip，解压提取文件

ArteryTek.AT32F435_437_DFP.2.1.5.pack，双击安装即可。 

5.2 软件使用流程 

5.2.1 创建工程 

安装 Artery 器件包后，Keil5 软件就会看到 Artery AT32F435 系列器

件，当创建工程时请选择器件“AT32F435”，如图 5-1 所示。 
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图 5-1 器件选择 

 

5.2.2 配置选项 

配置 Device 

如上述过程创建工程后，“Device”选项显示器件为“AT32F435”，软

件包为“ArteryTek.AT32F435_437_DFP.2.1.5”，如图 5-2 所示。 

图 5-2 配置 Device 
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配置 Target 

“Target”选项的 IROM1 和 IRAM1 自动关联器件 AT32F435 的内存

设置，如图 5-3 所示。 

例如： 

IROM1： 

- 起始地址：0x8000000 

- 大小：0x100000 

IRAM1： 

- 起始地址：0x20000000 

- 大小：0x60000 

图 5-3 配置 Target 

 
 

配置 C/C++ 

配置“C/C++ > Preprocessor Symbols > Define”和“Include 

Paths”选项，如图 5-4 所示。 

例如： 

AT32F435 

USE_STDPERIPH_DRIVER 

AT_START_F435_V1 
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图 5-4 配置 C/C++ 

 
 

配置 Debug 

如果使用 J-Link 仿真器，配置“Debug > J-LINK/J-TRACE Cortex”选

项，如图 5-5 所示。 

图 5-5 配置 Debug 

 

 

参照表 3-2 的方式连接 J-Link 仿真器后，单击“Settings”，配置 J-

Link/J-Trace Target Driver，如图 5-6 所示。 

例如： 
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 Port：SW 

 SWD IDCODE：0x2BA01477 

图 5-6 配置 J-Link 

 

 

配置 Flash 

配置“Utilities > Settings”选项，选择 Flash 下载方式和编程算法，如

图 5-7 所示。 

例如： 

下载功能： 

- Erase Sectors 

- Program 

- Verify 

Flash 编程算法： 

- 1M 
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图 5-7 配置 Flash 

 

5.2.3 编译 

完成软件工程选项配置和代码编写后，单击“Build”（ ）或

“Rebuild”（ ），编译当前软件工程。 

5.2.4 下载 

完成软件工程编译后，检查是否已正确连接 J-Link 仿真器，单击

“Download”（ ），下载软件编程设计，如图 5-8 所示。 

下载完成后，按下板材的 KEY3 按键（即 MCU NRST），复位 MCU，

运行程序。 
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图 5-8 下载 

 

5.2.5 单步调试 

完成软件编程设计下载后，如果用户软件编程设计出现问题，可以使用

J-Link 仿真器单步调试当前软件编程设计。 

直接单击“Start/Stop Debug Session”（ ），进入单步调试，如图

5-9 所示。 
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图 5-9 单步调试 

 

5.3 参考设计 

Gowin_EMPU(GW5AS-25)支持 Keil5（已测试软件版本：V5.26）软

件的软件编程参考设计，通过点击此链接 Gowin_EMPU(GW5AS-

25)_V1.0.zip 获取如下参考设计： 

…\sdk\gowin\ref_design\MCU_RefDesign\MDK_RefDesign\usart1_pri

ntf 

…\sdk\gowin\ref_design\MCU_RefDesign\MDK_RefDesign\freertos 

…\sdk\gowin\ref_design\MCU_RefDesign\MDK_RefDesign\rt_thread_

nano 

…\sdk\gowin\ref_design\MCU_RefDesign\MDK_RefDesign\ucos_iii 

 

https://cdn.gowinsemi.com.cn/Gowin_EMPU(GW5AS-25)_V1.0.zip
https://cdn.gowinsemi.com.cn/Gowin_EMPU(GW5AS-25)_V1.0.zip
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6XMC 接口设计 

6.1 功能描述 

XMC 是一个将 AHB 传输信号与外部存储器信号相互转换的外设，支持

的外部存储器有静态随机存储器 SRAM、NOR Flash、PSRAM、NAND 

Flash、PC 卡和同步动态随机存储器 SDRAM，另外 XMC 接口还可以用于

LCD 屏。 

6.2 功能框图 

XMC 接口分为 4 个类型，每个类型驱动不同的存储器，对应使用的引

脚部分相同，部分不同，如图 6-1 所示。 
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图 6-1 XMC 功能框图 

 

6.3 信号描述 

Gowin_EMPU(GW5AS-25)支持 XMC 同步复用和异步复用模式，XMC

接口的信号在 FPGA 一侧的描述如表 6-1 所示。 

表 6-1 XMC 信号描述（FPGA 侧） 

名称 位宽 I/O 描述 与 FPGA 互连的 I/O 名称 

XMC_CLK 1 in 时钟信号 P2-152 

XMC_NE 1 in 片选信号 P2-164 

XMC_NADV 1 in 地址锁存或地址有效信号 P2-176 

XMC_NOE 1 in 输出使能信号 P2-153 

XMC_NWE 1 in 写使能信号 P2-34 

XMC_NWAIT 1 out 等待信号 P2-159 

XMC_LB 1 in 字节选择信号 P2-180 

XMC_UB 1 in 字节选择信号 P2-181 

XMC_A [25:16] in 地址总线 XMC_A[16]：P2-101 
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名称 位宽 I/O 描述 与 FPGA 互连的 I/O 名称 

XMC_A[17]：P2-102 

XMC_A[18]：P2-103 

XMC_A[19]：P2-3 

XMC_A[20]：P2-4 

XMC_A[21]：P2-5 

XMC_A[22]：P2-6 

XMC_A[23]：P2-2 

XMC_A[24]：P2-165 

XMC_A[25]：P2-166 

XMC_D [15:0] inout 数据总线/地址数据复用总

线 

XMC_D[0]：P2-107 

XMC_D[1]：P2-119 

XMC_D[2]：P2-145 

XMC_D[3]：P2-146 

XMC_D[4]：P2-68 

XMC_D[5]：P2-47 

XMC_D[6]：P2-50 

XMC_D[7]：P2-51 

XMC_D[8]：P2-75 

XMC_D[9]：P2-76 

XMC_D[10]：P2-78 

XMC_D[11]：P2-79 

XMC_D[12]：P2-81 

XMC_D[13]：P2-92 

XMC_D[14]：P2-99 

XMC_D[15]：P2-100 

 

XMC 接口的信号在 Cortex-M4 MCU AT32F435 一侧的信号描述如表

6-2 所示。 

表 6-2 XMC 信号描述（MCU 侧） 

信号名称 引脚名称 复用功能 

XMC_CLK PD3 SPI2_SCK / I2S2_CK / 

SPI2_MISO / USART2_CTS / 

QSPI1_SCK / XMC_A8 / XMC_CLK / 

DVP_D5 

XMC_NE PG12 QSPI2_IO1 / SPI4_MISO / 

USART6_RTS_DE / CAN2_TX / XMC_NE4 

XMC_NADV PB7 TMR4_CH2 / TMR8_BRK / 
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信号名称 引脚名称 复用功能 

I2C1_SDA / SPI4_SCK / I2S4_CK / 

USART1_RX / QSPI2_IO1 / 

XMC_NADV / DVP_VSYNC / SDIO1_D0 

XMC_NOE PD4 SPI2_MOSI / I2S2_SD / 

USART2_RTS_DE / XMC_A9 / XMC_NOE 

XMC_NWE PC2 TMR20_CH2 / 

SPI2_MISO / I2S2_SDEXT / UART8_TX / 

SDIO2_D2 / EMAC_MII_TXD2 / 

XMC_SDCS0 / XMC_NWE 

XMC_NWAIT PD6 SPI3_MOSI / I2S3_SD / USART2_RX / 

XMC_A11 / XMC_NWAIT / DVP_D10 

XMC_LB PE0 TMR4_EXT / TMR20_EXT / UART8_RX / 

XMC_LB / XMC_SDDQML / DVP_D2 

XMC_UB PE1 TMR1_CH2C / TMR20_CH4 / UART8_TX / 

XMC_UB / XMC_SDDQMH / DVP_D3 

XMC_A[16] PD11 I2C2_SMBA / USART3_CTS / 

QSPI1 _IO0 / 

XMC_A14 / XMC_SDBA0 / 

EMAC_MII_RXD2 / XMC_A16_CLE 

XMC_A[17] PD12 TMR4_CH1 / I2C2_SCL / 

USART3_RTS_DE / QSPI1 _IO1 / 

XMC_A15 / XMC_SDBA1 / 

EMAC_MII_RXD3 / XMC_A17_ALE 

XMC_A[18] PD13 TMR4_CH2 / I2C2_SDA / 

UART8_TX / QSPI1_IO3 / 

XMC_SDCLK / XMC_A18 

XMC_A[19] PE3 TMR3_CH1 / TMR20_CH2 / 

XMC_A19 / DVP_D9 

XMC_A[20] PE4 CLKOUT1 / TMR3_CH2 / 

SPI4_CS / I2S4_WS / TMR20_CH1C / 

XMC_A20 / DVP_D4 

XMC_A[21] PE5 TMR3_CH3 / TMR9_CH1 / 

SPI4_MISO / TMR20_CH2C / 

XMC_A21 / DVP_D6 

XMC_A[22] PE6 TMR3_CH4 / TMR9_CH2 / 

SPI4_MOSI / I2S4_SD / TMR20_CH3C / 
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信号名称 引脚名称 复用功能 

XMC_SDNRAS / XMC_A22 / DVP_D7 

XMC_A[23] PE2 TMR3_EXT / SPI4_SCK / I2S4_CK / 

TMR20_CH1 / 

QSPI1_IO2 / XMC_SDNCAS / 

EMAC_MII_TXD3 / XMC_A23 

XMC_A[24] PG13 QSPI2_SCK / SPI4_MOSI / I2S4_SD / 

USART6_CTS / 

EMAC_MII_TXD0 / EMAC_RMII_TXD0 / 

XMC_A24 

XMC_A[25] PG14 QSPI2_IO0 / SPI4_CS / I2S4_WS / 

USART6_TX / QSPI1_IO3 / 

EMAC_MII_TXD1 / EMAC_RMII_TXD1 / 

XMC_A25 

XMC_D[0] PD14 TMR4_CH3 / I2C3_SCL / 

UART8_RX / XMC_D0 

XMC_D[1] PC6 TMR3_CH1 / TMR8_CH1 / I2C1_SCL / 

I2S2_MCK / USART6_TX / XMC_A0 / 

SDIO1_D6 / DVP_D0 / XMC_D1 

XMC_D[2] PC11 TMR5_CH3 / I2S3_SDEXT / SPI3_MISO / 

USART3_RX / UART4_RX / 

QSPI1_CS / SDIO1_D3 / 

DVP_D4 / XMC_D2 

XMC_D[3] PC12 TMR11_CH1 / I2C2_SDA / 

SPI3_MOSI / I2S3_SD / 

USART3_CK / UART5_TX / 

SDIO1_CK / DVP_D9 / XMC_D3 

XMC_D[4] PE7 TMR1_EXT / UART7_RX / 

QSPI2_IO0 / XMC_D4 

XMC_D[5] PA3 TMR2_CH4 / TMR5_CH4 / TMR9_CH2 / 

I2S2_MCK / USART2_RX / QSPI2_IO3 / 

SDIO2_CMD / EMAC_MII_COL / 

XMC_D5 

XMC_D[6] PA4 SPI1_CS / I2S1_WS / 

SPI3_CS / I2S3_WS / 

USART2_CK / USART6_TX / 

SDIO2_D4 / SDIO2_D0 / OTGFS2_SOF / 

DVP_HSYNC / XMC_D6 
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信号名称 引脚名称 复用功能 

XMC_D[7] PA5 TMR2_CH1 / TMR2_EXT / TMR8_CH1C / 

SPI1_SCK / I2S1_CK / 

USART6_RX / QSPI2_IO2 / 

SDIO2_D5 / SDIO2_D1 / XMC_D7 

XMC_D[8] PE11 TMR1_CH2 / SPI4_CS / I2S4_WS / 

UART5_RX / XMC_D8 

XMC_D[9] PE12 TMR1_CH3C / SPI1_CS / I2S1_WS / 

SPI4_SCK / I2S4_CK / XMC_D9 

XMC_D[10] PE13 TMR1_CH3 / SPI1_SCK / I2S1_CK / 

SPI4_MISO / XMC_D10 

XMC_D[11] PE14 TMR1_CH4 / SPI1_MISO / 

SPI4_MOSI / I2S4_SD / XMC_D11 

XMC_D[12] PE15 TMR1_BRK / SPI1_MOSI / I2S1_SD / 

XMC_D12 

XMC_D[13] PB12 TMR1_BRK / TMR5_CH1 / 

I2C2_SMBA / SPI2_CS / I2S2_WS / 

SPI4_CS / I2S4_WS / 

SPI3_SCK / I2S3_CK / 

USART3_CK / CAN2_RX / 

EMAC_MII_TXD0 / EMAC_RMII_TXD0 / 

OTGFS2_ID / XMC_D13 

XMC_D[14] PD9 USART3_RX / EMAC_MII_RXD0 / 

MAC_RMII_RXD0 / XMC_D14 

XMC_D[15] PD10 USART3_CK / EMAC_MII_RXD1 / 

EMAC_RMII_RXD1 / XMC_D15 

注！ 

如果 XMC 接口的信号复用为其他功能，请参照表 6-1 约束相关信号在 FPGA 一侧的 I/O

位置，信号方向按照所复用的实际输入输出方向定义。 

6.4 参考手册 

请参照表 2-3 的数据手册和应用笔记“XMC”。 

6.5 参考设计 

Gowin_EMPU(GW5AS-25)提供同步复用与异步复用的 XMC 接口参考

设计。 
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6.5.1 同步复用 

通过点击此链接 Gowin_EMPU(GW5AS-25)_V1.0.zip 获取如下参考设

计： 

…\sdk\gowin\ref_design\FPGA_RefDesign\xmc_sync 

…\sdk\gowin\ref_design\MCU_RefDesign\MDK_RefDesign\xmc_sync 

…\sdk\gowin\ref_design\MCU_RefDesign\GMD_RefDesign\xmc_sync 

程序运行结果如下所示。 

Cortex-M4:AT32F435ZGV7 

Synchronous PSRAM mode of XMC interface. 

rxbuffer[0] is 1224 

rxbuffer[1] is 1234 

rxbuffer[2] is 1244 

rxbuffer[3] is 1254 

rxbuffer[4] is 1264 

rxbuffer[5] is 1274 

rxbuffer[6] is 1284 

rxbuffer[7] is 1294 

data is right 

6.5.2 异步复用 

通过点击此链接 Gowin_EMPU(GW5AS-25)_V1.0.zip 获取如下参考设

计： 

…\sdk\gowin\ref_design\FPGA_RefDesign\xmc_async 

…\sdk\gowin\ref_design\MCU_RefDesign\MDK_RefDesign\xmc_asyn

c 

…\sdk\gowin\ref_design\MCU_RefDesign\GMD_RefDesign\xmc_asyn

c 

程序运行结果如下所示。 

Cortex-M4:AT32F435 

Asynchronous PSRAM mode of XMC interface. 

rxbuffer[0] is 1224 

rxbuffer[1] is 1234 

https://cdn.gowinsemi.com.cn/Gowin_EMPU(GW5AS-25)_V1.0.zip
https://cdn.gowinsemi.com.cn/Gowin_EMPU(GW5AS-25)_V1.0.zip


6 XMC 接口设计 6.5 参考设计 

 

MUG1186-1.1 53(53) 

 

rxbuffer[2] is 1244 

rxbuffer[3] is 1254 

rxbuffer[4] is 1264 

rxbuffer[5] is 1274 

rxbuffer[6] is 1284 

rxbuffer[7] is 1294 

data is right 
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